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1 Getting Started 

1.1 UNDERSTANDING DATABASES 

Databases are, very simply, tools to efficiently store, organize, and 
access information.  What makes a database different from a 

spreadsheet is its ability to organize information based on the 
relationships between them in a way that minimizes duplication and 

errors.  To understand how databases work, we recommend visiting our 
What Is Microsoft Access Used For page. 
 

1.2 HOW DESIGNER WORKS 

Designer asks you a series of questions about what you want to track, 
and how you want it to appear to your users.  Once you are satisfied 

with the setup of your database, Designer creates your tables and 
forms.  You have a chance to review the tables and forms, and if 

needed, create a new version of your database with changes. 
 

Important!   
Designer does not have the ability to change an existing database, so 

once you complete your project and begin adding data to your 
database, you will need to use the standard Microsoft Access table and 
form design modes to make changes. 
 

2 Starting Designer 
Access 2007 and higher users, be sure to select “Options…” then “Enable 

this content” when prompted. 

 
 

 
 

2.1 STEP 1:  STARTING FROM SCRATCH, USING A TEMPLATE, 
OR IMPORTING DEMO DATA 

When you start Designer, you will first need to choose whether you 
want to start a fresh database (with no tables or fields defined), 

http://www.opengatesw.net/
http://www.opengatesw.net/ms-access-tutorials/What-Is-Microsoft-Access-Used-For.htm?utm_source=designerapplicationguide
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continue an existing project, use one of the existing templates, or 
import work you have already completed in another copy of Designer. 

 

2.2 STEP 2:  WHAT THINGS DO YOU WANT TO TRACK? 

In this step, you tell Designer what main things you want to track with 
your database.  Each “thing” will become a table in your database, and 

in steps after this you will be able to further define the detailed 
information you want manage in the database.   

 
For this step, it is best to think in very high level terms.  It may be 
helpful to verbally talk through what you want to manage in your 

database.   
 

Tip  
If you aren't sure about something, ask whether you would track the 
thing all by itself.  For example, you would track Vehicles by 
themselves, but not Colors.  Colors are simply an attribute about a 
Vehicles. 
 

   

 
Figure 1: Things You Want to Manage screen 

 

In Figure 1 above, you can see that we will track Patients, Physicians, 
Visits, Visit Notes, Prescriptions, etc.  Note, however, that we do not 
place “Patient First Name” or “Patient Last Name” here.  Defining 

specific details about each of these things comes in the next step. 

http://www.opengatesw.net/
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2.3 STEP 3:  DEFINING RELATIONSHIPS AND FIELDS 

2.3.1 HOW DO X AND Y RELATE? 

In this step, you will notice the left-hand side of the wizard form the 

list of all the things you entered in the prior step as shown in Figure 2 
below.  With the exception of the first table you named, you will be 
prompted to indicate how each thing your database will track is related 

to the other things.  In the drop-down box, choose one of the other 
things that your database will track.  While you will only be asked to 

specify a single thing that relates to the current item, you will have an 
opportunity to link many things together through this process.   
 

Tip  
You will want to select things that directly relate to one another.  While 
it may seem that everything is related to everything else, remember 
that something usually has a few direct relationships to any other thing, 
and indirect relationships to many more. 
 
For example, a Customer, Order, and Product are all related.  But the 

direction relationships are between a Customer and Order, and an 
Order and Products.  You can always identify which Customer owns 
which Products, but it is done through the Order. 
 

 
After selecting another item in the drop-down list, you will be asked 

two questions, and your responses will dictate to Designer how the two 
things relate to one another.  Designer uses this information to create 
the primary and foreign key relationships between tables in the 

database.  If you feel you made an error, you can always select the 
‘(change my selection)’ to try again. 

 

Important 
If you answer ‘Yes’ to both questions, Designer will know that the two 
things relate in what is called a “many-to-many” relationship.  You will 
notice your database contains a table to join the two.  For example, if 
you say that “Orders” and “Products” have a many-to-many 
relationship, Designer will create a table ‘tblOrderProductjoin’ which will 

join the two things together. 
 

 

http://www.opengatesw.net/
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Figure 2:  Relationships 

2.3.2 DEFINING FIELDS 

After answering how your things relate, you will see a space at the 

bottom of the form to enter the fields you want to store for the current 
item.  For each row, you enter the plain-language name of the field, 
the select what sort of information you want to store in the field.  Note 

that only the columns with a * are required. 
 

Important 
You do not need to specify any sort of unique identifier field such as 
“CustomerID” here.  Designer automatically creates a Microsoft Access 
autonumber field for each table for you. 
 

 

 
Figure 3:  Defining Fields 

http://www.opengatesw.net/
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Type of Data 

Text The field in the table will accept up to 255 alphanumeric 
characters. 
 

Memo The field in the table will accept up to 65,536 alphanumeric 
characters.  Note that using this type of field will take up more 

space in your database, and is not searchable in the same 
manner as a ’Text’ field. 
 

Number The field in the table will only accept a numeric value. 
 

Date The field in the table will only accept a date or date/time value.  
The date will be formatted according to your machine’s system 

date format setup. 
 

Yes/No Displays a checkbox in the table. 
 

Attachment  Access 2007 and 2010 only.    An attachment field allows you to 
attach multiple files to a record within your MS Access database. 

 

 
Display Options 

Currency Displays the data in the currency setup for your local machine. 

Only available if you say the type of data is ‘Number.’ 
 

Date The field in the table will only accept a date or date/time value.  
The date will be formatted according to your machine’s system 
date format setup. 
 

Number Choose to display no decimals, or two decimals.  The full number 
of decimals will be stored in the table, but will be rounded 

according to the option you choose. 
 

Percent  
 

Phone 

Number 

Choose either the US or European phone number format.  Only 

available if you say the type of data is ‘Number.’ 
 

Postal Code Choose either the US or Canadian postal code format.  Due to the 
wide variability of UK and other international postal code formats, 
only the US and Canada are available.   Only available if you say 
the type of data is ‘Text.’ 
 

 
Dropdown Field 
In some cases you may want to limit your users to select from a list of 

specific text values.  For these instances, select the “Dropdown” check 
box for your field.  Designer will automatically create a table to store 

your dropdown field values, and link your main table to that lookup 
table with a dropdown box, as shown in Figure 4.  Designer will also 
automatically create forms for each dropdown field to help you and 

your users enter lookup values. 
 

http://www.opengatesw.net/
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Figure 4: Lookup Fields and Tables 

 

Tip  
Use dropdown fields for information that isn’t likely to change often, 
and you want to make sure your users don’t enter values that aren’t 
valid to maintain data consistency.  Good examples are State/Province 
names, status names, category names.  Avoid using dropdowns for 

things like people’s first names, unique ID numbers (e.g., social 
security or national IDs) as it will unnecessarily complicate your data 
entry. 

 

 

When you check a field to be a dropown list, Designer will also ask you 
if you would like to define what the list of possible values should be.  
This step is optional, and you can always add values in your lookup 

forms once your database has been created. 
 

 
Required Field (advanced setting) 
Checking this box will mean that a user must enter a value in this 

field, otherwise they will not be able to save the record. 
 

Unique Field (advanced setting) 
Checking this box will mean that a user must enter a unique value in 
this field, otherwise they will not be able to save the record. 

 

http://www.opengatesw.net/
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2.4 STEP 4:  CREATING FORMS 

In this step, check the boxes next to the names of the tables in your 

database that you want Designer to create forms on your behalf.  
Uncheck a box to prevent Designer from creating a form for the table. 
 

 
 

2.5 STEP 5:  DESIGNING YOUR FORMS 

Next, Designer will prompt you to design each form that was checked in 
the previous step. 

2.5.1 FORM PROPERTIES 

In the top section of the form, you can specify the caption of the form, 

how you want to order records, and how you want the form to behave. 

 
Figure 5:  General Form Properties 

 

Tip  
You can always change your choices after the form has been created by 
opening the Microsoft Access form properties dialog and changing your 
selections. 
 

   
If you wish to see the unique identifier for each record on your form, 

click on the "Show Unique Identifier" box at the far right.  This field will 

http://www.opengatesw.net/
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be disabled, and automatically increment to the next number when new 
records are created in your form. 

2.5.2 FORM HEADER FIELDS. 

In the Form Detail Fields section, you can select from the fields you 
already defined for your table in Step 3.  You can also choose to 

change the label text that will appear on the form if desired.  Note that 
the field width on the form will be determined by the length of the 
label text.  You can always choose to change the width of the field on 

the form after the form is created. 
 

 
 
Not in List Behaviour 
If you indicate that a field should appear as a dropdown list, Designer 

will ask you during the form design phase whether you want to allow 
users to add new values to your dropdown list “on the fly” while 

entering data.  If you do not want users to be able to add their own 
dropdown list values, click the “Allowed” link to toggle it to “Not 
Allowed.” 

2.5.3 CALCULATED FIELDS 

One of the most powerful capabilities of a database, or Excel, is to be 
able to calculate values rather than requiring manual updates.  Like 

Excel, Access supports field-level calculations.  The notation is similar, 
but does require some adjustment.  In Excel, a formula is expressed 
as “=C12*C13” where in Access you would express that same formula 

using field names instead of cells:  =[FieldName1]*[FieldName2]. 
 

Click the “Add Calculated Field” to create a new field in your form that 
can use one or more fields in the form as the source.  For example, if 
you have a field “Quantity” and another field “Price/Unit” you can add 

a calculated field “Line Total” that will be the product of the two fields. 
 

Tip  
You can calculate the difference between two dates, or the current date 
and a field in your form using the DateAdd() and DateDiff() methods.  

http://www.opengatesw.net/
http://office.microsoft.com/en-us/access-help/dateadd-function-HA001228810.aspx?CTT=3
http://office.microsoft.com/en-us/access-help/datediff-function-HA001228811.aspx
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More information about the formula syntax is available on Microsoft’s 

website (click on the hyperlinks for either method above. 
 

 

2.5.4 RELATED INFORMATION 

Designer uses the information you provided earlier about how things 

relate to one another to help you create better forms.  The Related 
Items box will show you all the related items you can include on your 

form, as well as how they will appear.  Note that the way they appear, 
as a subform or dropdown, is dictated by how things relate.  For 
example, if you can have only one Customer assigned to a Contact, 

the Contact form will show a dropdown box where you can choose 
from a list of Customers.  Similarly, the Customer form would show a 

subform with the details of each related Contact. 

 
Figure 6: Related Items 

 
When you check a related item that is designated to appear as a 

dropdown, Designer will ask you how you want the dropdown box to 
appear to the user.  In the Dropdown Builder form, you can choose 
which fields should appear in the dropdown box on your form. 

 

 
Figure 7: Dropdown Builder 
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2.5.5 MANY-TO-MANY FORM RELATIONSHIPS 

For any tables in your database that are classified as a many-to-many 
relationship, you will need to follow a few extra steps to set up your 

forms to display the information properly.  The forms with many-to-
many relationships will appear as shown in Figure 8 below. 

 
Figure 8:  Many-to-Many Relationship 

 

By default, Designer will select the first field for the table (in the 
example above, "Events") to display when the dropdown list is 

selected.  However, you may wish to display a different value in the 
dropdown box.  To do so: 
 

1) Open the form in Design mode. 
2) Delete the “Please see user’s guide” label in the subform. 

3) Select the “Fields List” option from the View menu in Access 
2000/2003, or the "Add Existing Fields" button from the Access 
2007 Design ribbon tab). 

 
4) Make sure the combo box is highlighted.  Open the Properties box 

for the field by right-clicking the field and select Properties.   

 
Figure 9: Combo Box Properties 

 
5) In the Properties dialog, select the “Data” tab. 

6) In the Data tab, select the Row Source icon as shown in Figure 10. 

http://www.opengatesw.net/
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Figure 10:  Row Source Selection 

 
7) Locate the field(s) that you want to display in the dropdown 

and drag it to the bottom portion of the screen as shown 
below.  Make sure to leave the first column "as-is." 

 
Figure 11:  Creating the Dropdown Rowsource 
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8) Close the Query design view. 
 

Repeat these steps for other many-to-many forms.  If the steps 
above are properly followed, your dropdown box will look as 

follows: 

 
 

2.6 STEP 6:  CREATING AND REVIEWING YOUR DATABASE 

After designing each of your forms, you are ready to create your 

database.  We recommend you look at the forms, enter test records, 
and make sure the fields and forms work as you want them to.  If you 

need to make changes, select “I’d like to make revisions…” button, and 
go through the Designer wizard, make revisions as needed, and then 
re-create your database. 

2.6.1 SAVING YOUR NEW DATABASE INTO UI BUILDER 

If you have also purchased UI Builder for Microsoft Access, you can 
save time by allowing Designer to add your new tables and forms into 

a new copy of UI Builder. 
 
When you choose to save your database into a UI Builder, Designer 

will create a copy of the selected UI Builder file, and will also add the 
first several forms as new menu items in UI Builder to help you get 

started. 
 
To save your Designer-created database into UI Builder: 

a) Check the " Save my new database into UI Builder for Microsoft 
Access" box. 

b) Select the "Browse" icon. 
c) Locate the copy of UI Builder that you have downloaded from 

OpenGate Software. 

d) Click "Ok" 
e) Click "Create my Database" 

f) Specify the location and name of your new database. 
 

http://www.opengatesw.net/
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Designer will copy the UI Builder database you selected, then save it 
to the location and name you specified in step (f).  Designer will then 

save all your new tables and forms into the UI Builder copy, and set up 
several menu buttons using the forms you have designed. 

 
If you choose to make revisions to your database, Designer will create 
another copy of UI Builder, and perform the same steps to create your 

new database until you are satisfied with the end results. 
 

Tip  
You do not need to select "Migrate" in the UI Builder setup wizard, as 
Designer has already migrated your forms and tables into the new copy 
of UI Builder. 
 

   

2.6.2 ADVANCED OPTIONS 

In the final step with the button labeled "Create my Database" you 
may select the "Advanced Options" button at the top right to access 

advanced settings.   

2.6.2.1 Automatically Created Fields 

Designer automatically adds several audit fields to every table.  The 
fields are, Date-Created, Created-By, Date-Modified, Modified-By.  
Uncheck the box if you do not want these fields to be added to each 

of your tables. 

2.6.2.2 Required Field Indicator 

You can choose to display an asterisk (*) after the caption of any 
field that is marked as a required field.  This has become a standard 

user interface best practice to help users understand which fields on 
a form they need to file out to save a record. 

2.6.2.3 Field Widths 

Designer will create the text boxes on your form using the field name 
as a guide for how large the box should be sized.  By default, the box 

width will roughly match the field name.  Select "Wide" or "Widest" to 
make the default text box sizes be larger than the field name caption. 

2.6.2.4 Font 

You can select from several popular fonts to use for your database's 
style. 
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3 Working With Your New Database 

3.1.1 FORM CUSTOMIZATION 

While Designer will create your data entry forms to include all the 

fields you specify in the Designer wizard, it is common to want to 
further customize your forms. 

 

 
Figure 12: Form Design View 

 
To open a form in the edit mode, right-click the form and select 
"Design View."  The Microsoft Access form design view is a very 

intuitive interface where you can move and resize your fields to your 
liking. 

 

 
Figure 13:  Adding fields to your form 

 

http://www.opengatesw.net/
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As shown in Figure 13 above,  you can drag other fields related to your 
form by selecting "Add Existing Fields," then dragging the field(s) from 

the Field List dialog box into the form itself. 

3.1.2 CHANGING TABLES 

Once Designer has created your tables and you have chosen to 

remove Designer, you can continue to make changes to your database 
tables.  To do so, you will need to use the standard Microsoft Access 
table design mode. 

3.1.3 CREATING QUERIES 

When creating queries and adding tables to the query design view, you 
will notice that Access automatically links related tables and fields 

together.  This is because Designer has automatically created the 
correct relationships between your tables.  As a result, you can drag 
fields from multiple tables to create consolidated “views” of your data. 

 

4 Resources to Help You With Microsoft Access 

4.1 OPENGATE SUPPORT 

Should you need assistance with Designer or other OpenGate products, 
please visit our support site, send an email to support@opengatesw.net, 

or visit our support forums online. 

4.2 GENERAL MICROSOFT ACCESS HELP 

UtterAccess.com - Dedicated MS Access community 

AccessWeb - Access examples and code snippets 
DatabaseDev.co.uk - Access Tutorials, Articles, and Downloads 

 

http://www.opengatesw.net/
http://www.opengatesw.net/support/supportmain.htm
mailto:support@opengatesw.net
http://www.opengatesw.net/support/SupportForums.htm
http://www.utteraccess.com/
http://www.theaccessweb.com/
http://www.databasedev.co.uk/

